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WARNINGS 

Although the Dynamic Pressure Measurement System (DPMS) is relatively robust, care must still be 

taken with its handling. 

 Avoid dropping the Dynamic Pressure (DP) modules. 

 Avoid over-pressuring the transducers. 

 The warranty will be void if a user dismantles any part of the DPMS without specific instructions 

from TFI.  Any significant damage will require the DPMS to be returned to TFI for maintenance. 

 The DPMS should be stored in a secure location when not in use. 

TFI CONTACT DETAILS 

Turbulent Flow Instrumentation – Victoria, Australia 

 Main website: www.turbulentflow.com.au 

 Support website: support.turbulentflow.com.au 

 Email support: support@turbulentflow.com.au 

 Phone support: (61 2) 6020 9250 

http://www.turbulentflow.com.au/
mailto:support@turbulentflow.com.au
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INTRODUCTION 

This document outlines the basic procedure for using the TFI Dynamic Pressure Measurement System 

(DPMS).  However, users are referred to the on-line User’s Guide for complete details of the DPMS and 

its operation.  The User’s Guide can be run from: 

 the software installation CD 

 the TFI Device Control software Help menu 

 the Windows Start menu (under ‘Program Files\TFI’) 

What is the DPMS? 

The DPMS is a multi-channel pressure measurement system that provides both time-averaged (static) 

and time-varying (dynamic) pressure measurements in real-time. 

The number of channels available in DPMS units varies from 32 to 1024, depending on the user 

requirements.  The system is capable of a linear frequency-response from 0 Hz to several kHz and is 

available in various full-scale ranges.  The measurement modules, or Dynamic Pressure (DP) modules, 

are supplied fully calibrated and ready to use.  Figure 1 shows a diagram of a DP module and a complete 

DPMS.  Figure 2 shows how a module may be removed from the DPMS rack. 

 
 

(a) 

 
 

(b) 

Figure 1: The main features of a DPMS: (a) a DP module; (b) a complete DPMS. 
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Figure 2: A DPMS rack showing a module being removed 

Included with the DPMS are the TFI Device Control software and the Real-Time Animated Contouring 

(R-TAC) software, for operating the DPMS and viewing measurements respectively. 

The Device Control software provides access to all functions of the DPMS, and can be used to configure 

measurements, obtain and view data, save data to disk, and interface with the R-TAC software.  R-TAC 

overlays dynamic pressure contours, in real-time, on an imported image of the measurement situation.  

This allows the user to see the fluctuating pressure contours directly on the object where measurements 

are taken. 

Package contents 

Your DPMS should have been supplied with the following items.  If any items appear to be missing or 

damaged, contact TFI as soon as possible. 

 Dynamic Pressure (DP) modules 

 Rack case for modules 

 Cables 

 Data acquisition Interface Unit 

 Software installation CD – TFI Device Control + R-TAC software 

 This guide & additional items that were ordered 

System requirements 

The requirements for running the Device Control software are listed below.  These requirements allow 

real-time viewing of data from the DPMS, and are the minimum required to run the software efficiently.  

The use of a slower processor may prevent real-time display capability, while the use of a faster 

computer may be required if there are a large number of channels. 

Table 1: Minimum required computer system for running the Device Control software 

Operating system Microsoft® Windows 2000 or XP 

Processor Pentium 1 GHz or equivalent 

RAM 128 Mb 

Display 1024x768, 65536 colours (16-bit) 

Storage (program) 15 MB 

Storage (data)# Approx. 120 kB/channel/minute (if saving all data) 

A/D card See below (normally supplied) 

# This only applies if saving all time-varying data.  Summary files of each run are less that 2 kB in size 

1.  Undo 4 
screws at the 
corners of the 

DP module 

2. Pull handle 
to remove 

module 
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The Device Control software currently supports the following analogue-to-digital (A/D) cards for 

operating the DPMS: 

 National Instruments E-series or M-series cards (for desktop and laptop computers) 

 Data Translations cards 

TFI can also customise the software to support other suitable A/D cards or data acquisition systems – 

contact us for further information. 

 Please follow the A/D card manufacturers’ instructions for installation of the A/D card before 

attempting to install and run the Device Control software. 
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GETTING STARTED 

Complete instructions for installing and using the DPMS are provided in the on-line User’s Guide.  The 

following pages only introduce the DPMS set-up and operation. 

Software installation 

Before installing the software, TFI Device Control with R-TAC, ensure that your data acquisition drivers 

are installed and operating correctly. 

 You will need administrator rights to successfully install the Device Control with R-TAC software. 

To install the Device Control with R-TAC software: 

 Insert the installation CD (run Startup.exe on the CD if installation does not start automatically). 

 Follow the on-screen instructions and upon reaching the Choose Components screen, refer to 

Figure 3. 

 
 

Figure 3: Software installation – Choosing which components are installed 

 All the devices that you have purchased should already be selected, but please ensure that the correct 

DAQ driver for the card that you are currently using is chosen. 

After installation is complete, you can run the software – you should not need to restart your computer. 

Software configuration 

Some basic settings need to be configured when the software is first run, or when the set-up is changed, 

in order to correctly use your instrumentation. 

Prior to configuring your DPMS (or any other device), ensure the data acquisition details are correct.  

When the Device Control software is run you can access information about the data acquisition devices 

1.  Select the appropriate 
data acquisition driver 

2.  Select the appropriate 
interface units 

3.  Select the appropriate 
DP modules 

4.  Scroll down and select 
other installation options 

as desired 
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available for use on the Advanced (DAQ) tab.  Check this first to ensure that your data acquisition 

devices have been identified. 

 Run the Device Control software – ignore any warning messages 

 Select Advanced (DAQ) from the Settings menu, then refer to Figure 4 below 

 
 

Figure 4: Software configuration – CheckingSelecting the Interface Unit 

 In most cases, there will only be one Interface Unit listed 

 When the Interface Unit is set to None, it is possible to set the data acquisition channels for all 

devices manually.  However, this is not normally done when using a DPMS and you should 

select the appropriate interface unit. 

 For DAQ devices that use a common input voltage range for all channels (e.g. some Data 

Translations A/D cards) it will also be necessary to choose the appropriate input voltage range 

on the Advanced (DAQ) tab (this is not shown above in Figure 4 but will appear if such a DAQ 

device is selected). 

Ensure your A/D card 
or Data-acquisition 
Interface Unit (DIU) 

is listed 

Selecting a DAQ 
Device will show it’s 

basic details here 

Some advanced 
settings for each DAQ 

Device may be 
available 
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 To choose and configure the devices that you wish to use, select the Devices tab (or choose 

Devices from the Settings menu) and refer to Figure 5. 

 
 

Figure 5: Software configuration – Adding and configuring devices 

 

 Repeat the steps shown in Figure 5 for each additional DP module or other device. 

 If your DAQ Interface Unit is not listed, go back and check the Advanced (DAQ) tab. 

 When using a DPMS you should select the appropriate interface unit.  Some custom units may allow 

the channels to be set up manually; however, this is not normally required. 

 Select the connector the DP Module is attached to from the Input Connection list (this will 

automatically configure the channel list – see the Hardware Set Up section for details about 

Interface Units and connections) 

 When using a rack to hold the modules, Channel corresponds to the particular slot in the rack that a 

DP Module is placed in.  The first slot in the rack will be the first channel used by the connector, the 

second slot will be the second channel, etc.  For example, for connector AI 1-4 the first slot will be 

Channel 1, the second slot will be Channel 2.  For connector AI 5-8, the first slot will be Channel 5. 

If a module is connected directly to connector AI 1-4, the Channel setting should be 1. 

 For cards that use a common input voltage range for all channels, the A/D Input Range is set on the 

Advanced (DAQ) tab (see Figure 4).  

 To use the R-TAC software, the Use R-TAC box must be checked for each DP Module for which R-

TAC data is required.  This must be done for at least one module before R-TAC will run. 

3. Select the 
DAQ Interface Unit 

(see note below) 

1. Select the 
required module 
(see Figure 1) 

and click Add  

2. The new device 
will be added to the 
Active Devices list 

4. Select the connector 
the DP module or rack 
is attached to on the 

interface unit 

5. Select the 
Channel the DP 

module is attached to 
on the A/D Input 
Connection (see 

note below) 

6. Select the 
required input 

voltage range on 
the A/D card 

(see note below) 

7. Check the 
Use R-TAC box 
if required (see 

note below) 
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Hardware set up 

After unpacking the DPMS, you should not have any difficulty connecting it – connectors should only 

fit in suitable sockets.  Refer to Figure 6 and Figure 7 for diagrams of the required connections. 

 

 

Figure 6: Schematic of the DPMS connections between the computer and Interface Unit 

 

 Connections can be made in any order, even when the computer is already turned on. 

 If the Interface Unit contains an internal A/D card (Data-acquisition Interface Unit or DIU), it will 

have a USB connector which plugs into a USB socket on your computer.  A USB 2.0 (high-speed 

USB) port should be used. 

If the A/D card is installed in your computer, the DAQ Interface cable will plug into the socket 

provided on the A/D card. 

 

 

Figure 7: Schematic of the different configurations possible between the Interface Unit and the DP modules 
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Interface Unit 

(b) Modules may be inserted in 
the DPMS rack, with the rack 
connected to the Interface Unit 
(see note below) 

To Interface unit 
Module Data cable 

(c) Modules may be connected 
via a cable to the DPMS rack, 
with the rack then connected to 
the Interface Unit 

Slot A Slot B Slot C Slot D 

DPM 1307 

DP module 

DPMS rack case 

DPM 1307 DPM 1308 DPM 1309 DPM 1310 

DPM 1307 

DP module 

Mains 
power 

Interface Unit 
external 
power cable 

Interface Unit 

Connect plug to the USB 
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 All Module Data cables have common wiring and are interchangeable. 

 Modules can be connected to the Interface Unit in three different ways: 

 (a) directly to the Interface Unit 

 (b) inserted in the rack case, which is then connected to the Interface Unit 

 (c) connected via a cable to the rack case, which is then connected to the Interface Unit 

 Module Data cables may also be connected together to extend the cable length. 

 The labels above the sockets on the Interface Unit indicate the DAQ card channels that those sockets 

connect to (AI stands for Analogue Input). 

 If a module is connected directly to the Interface Unit, it is always connected to the first channel 

listed on the socket, e.g. if a module is directly connected to AI 1-4 on the Interface Unit, it is on 

channel 1.  This information is required for step 5 in Figure 5 of the Software Configuration. 

 When a rack is connected to the Interface Unit, e.g. to socket AI 5-8, slot A corresponds to the first 

channel (e.g. channel 5), slot B corresponds to the second channel (e.g. channel 6), slot C 

corresponds to the third channel (e.g. channel 7) etc.  This information is required for step 5 in 

Figure 5 of the Software Configuration. 

Power Lights 
The DP module power lights indicate when power is connected to the modules. 

Reference Port 
The reference pressure port (see Figure 1) provides the common reference pressure for the transducers.  

Therefore, pressures measured by the DPMS are relative to the pressure applied at the reference port. 
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Advanced software configuration – Tube response 

Advanced software settings need to be configured for each new measurement situation.  The reasons and 

procedure for doing this are detailed below. 

The DPMS measures dynamic pressure by sensing the pressure fluctuations at the end of the pressure 

tubes that connect the measurement points to the DP modules.  Amplitude and phase distortions are 

introduced into the pressure fluctuations as they propagate along the tubing from the measurement point 

to the pressure transducer. 

The default Device Control software configuration assumes a linear tubing response, which is 

appropriate for time-averaged (static) measurements.  However, to take accurate time-varying (dynamic) 

measurements it is necessary to provide the frequency response function (transfer function) of the tubing 

being used.  Figure 8 shows how effectively a fluctuating pressure signal can be recreated by applying 

the appropriate tube response function (the corrected pressure is within 2% of the actual pressure, 

compared to 30% amplitude error and a large phase error for the uncorrected pressure).  If an accurate 

frequency response function is not used, the resulting frequency content of time-varying pressure 

fluctuations will be incorrect. 

A tubing frequency response function can be either theoretical or experimental.  A theoretical function 

can be generated by the TFI Device Control software’s Frequency Response Calculator.  Please contact 

TFI about using experimentally acquired frequency response functions. 

 

Figure 8: Sample data showing uncorrected and corrected pressure 

measurements.  Data were obtained using 1200 mm of 1.2 mm ID 

tubing at a sample rate of 5 kHz. 

 

Calculating Tubing Frequency Response 
Amplitude and phase distortions in the pressure fluctuations depend on both the length and internal 

diameter of the pressure tubing, and can be corrected for by linearising the measured signal (i.e. 

returning it to its original undistorted state).  The Frequency Response Calculator supplied with the TFI 

Device Control software can be used to generate theoretical frequency response functions for this 

purpose. 

The following procedure is greatly simplified by using identical tubing configurations (i.e. number of 

segments per tubing line, segment diameters and lengths) for every channel of a DPM. 

With the Device Control software running: 

 Select Devices from the Settings menu, select the DP module for which the transfer functions 

will be specified, then click on Calibration … 

 Select the Transfer Function tab 

 Within the Transfer Function File area, select Create 
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The next part of the procedure depends on whether identical sizes and lengths of tubing are being used 

for all the channels/pressure ports. 

If identical diameter and length tubes are used for all channels, known as a Common Tubing 

Configuration, then 

1 In Tube Properties select the Number of Tubes that make up an individual tubing line (one or 

more segments, the internal tubing in the DP module, are already specified and ‘greyed out’) 

2 Detail the tubing inner Diameter and Length of every segment of tubing from the DP module to 

the measurement point (see information notes below) 

3 In Response Properties, set Max Frequency to at least half the data acquisition rate (it does 

not matter if this value is set to a higher value) (see information notes below) 

4 In Fluid Properties set the Temperature and barometric Pressure at which the theoretical 

response function is to be calculated (see information notes below) 

5 Select Save Current Response from the File menu, enter a file name and select Save 

6 Once finished select Exit from the File menu 

7 Confirm use of the new theoretical response by selecting Yes 

If there are any variations in either the diameter or length of tubes used for different channels, known as 

a Varied Tubing Configuration, then 

1 Complete steps 1-4 for channel 1 as for a Common Tubing Configuration – this is Response 1 

2 Select Add from the Response menu at the top of the page 

3 Complete steps 1-4 for channel 2 – this will be Response 2 

4 Repeat this process for every other channel in the DPM, in the channel order 

 If a particular channel has identical tubing to an earlier channel, select the earlier 

channel tab, and select Copy from the Response menu 

 Unwanted responses can be deleted by selecting the response and choosing Remove 

from the Response menu 

5 When all channel responses are complete, select Save All Responses from the File menu, enter 

a file name and select Save 

6 Once finished select Exit from the File menu 

7 Confirm use of the new theoretical response by selecting Yes when prompted 

 The units used for the various parameters on the Calculator page can be changed by going to the 

Units menu at the top of the page 

 The tube dimensions (length and internal diameter) must be specified accurately in order for the 

calculated frequency response function to give accurate results 

 The order that the tubing segments are listed in must start at the transducer end and proceed, in 

order, to the measurement point – this should include any connectors and restrictors 

 The data acquisition rate is set on the Advanced page of the Device Control Settings Form 

 Temperature and barometric pressure have minimal effect on the frequency response and can 

therefore be set to nominal values – small changes (e.g. ±10° C) do not require the frequency 

response to be recalculated 

 Select the Plot or Plot All buttons at the bottom of the Calculator page to view the theoretical 

response functions 
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The above procedure needs to be repeated for every DP module in the DPMS. 

 Close the Transfer Function tab 

 On the DP Devices tab select the next device to be configured 

 Repeat the above procedure 

 If a module uses identical tubing configurations for its channels as that of an existing module, the 

same transfer function file can be used for both modules.  Use Select in the Transfer Function tab 

of a particular module to select a previously defined transfer function file and use it for this module. 
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R-TAC configuration 

The Real-Time Animated Contouring (R-TAC) software provides contour generation and plotting of the 

pressure signals.  The user may import a chosen background image (photo or drawing) and specify the 

location of the pressure measurement points (taps) on the image, including zones for contour generation, 

so that the fluctuating pressures can be visualised in the actual measurement situation.  This can be 

viewed while measurements are being taken or can be played back later for further analysis. 

Figure 9 shows the R-TAC main form.  The R-TAC software can be accessed from a button at the top of 

the main form of the Device Control software (shown in Figure 11 on page 18), or by clicking on the 

Start Sampling button on the same form. 

 As noted on page 6, the Use R-TAC box must be checked on the DP Devices tab in the Settings 

menu for each DP module from which R-TAC data is required.  This must be done for at least one 

module before the R-TAC software will run. 

 

 

 

Figure 9: The main screen of the R-TAC software 

 

Mode 
The R-TAC software operates in two possible modes: configuration; or operation.  R-TAC must be put 

in configuration mode in order to configure it for operation (e.g. import an image, and define or change 

zones or taps).  Upon running R-TAC for the first time for a given measurement situation, configuration 

must occur before data will be displayed in the Operate mode. 

To put R-TAC into configuration mode: 

 Select the R-TAC button from the Device Control software main form 

Legend 
Settings 

Toolbar 

Configuration Tabs 
Imported image 

Zone boundary 

User defined taps 

Current cursor x- and y-coordinates Image window 
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 Select Config from the Mode menu on the R-TAC main form 

The operational mode is automatically activated by selecting the Start Sampling or Real-Time Monitor 

buttons on the Device Control software main form (see Figure 11).  In operational mode, R-TAC plots 

the measured pressure contours on an imported image according to the configuration settings entered by 

the user. 

 If configuration settings have not been entered (e.g. an image has not been loaded, or pressure taps 

and zones are not defined) the R-TAC software will not display anything. 

 
R-TAC main form 
As shown in Figure 9, the R-TAC main form consists of a menu bar, tool bar, five configuration tabs and 

an image window. 

Menu bar.  The menu bar controls the loading and saving of configuration files, print options, operation 

or configuration mode and the help facility.  These functions are straightforward and will not be 

discussed any further here, other than to say that the ability to save particular configurations at any 

stage, and load them for later use or further development, greatly reduces the configuration time 

required for new measurement situations. 

Toolbar.  The toolbar, immediately below the menu bar, contains the tools for configuring the taps and 

zones on the imported image.  Placing the cursor over a tool button will bring up the tool-tip describing 

the tool function.  Clicking on any of the tool buttons activates the selected tool.  

 
Select When the cursor is placed over an existing tap (or zone 

vertex) in the image window, the corresponding 

Configuration Tab and tap number are displayed on the left 

of the R-TAC main form 

 
Add Tap Clicking anywhere within the image window will place a 

tap at that point 

 
Create Zone (Rectangular) Clicking and dragging creates a rectangular zone, clicking 

again sets the zone size 

 
Create Zone (Polygon) Each click of the cursor within the image window sets a 

vertex of the polygon.  To complete the polygon, on the last 

vertex, double-click the cursor instead of a single-click. 

 
Move Place the cursor over a tap or zone vertex, click and drag to 

move it to a new location, and complete the move with a 

single click once the point is in the desired position 

 
Delete Move the cursor over a tap or zone vertex that is to be 

deleted (the cursor will change to a pointer when over a 

valid point) and click once.  You will be asked to confirm 

whether you wish to delete the point. 

 

All the tools are simple to operate and it is suggested that the user experiment with using them to 

quickly gain an appreciation of how they work. 

Image window.  Below the toolbar on the right-hand side of the R-TAC main form is the image window.  

This is where imported images, zones, pressure taps, and contoured data are displayed.  In configuration 

mode, the image window is also where the pressure taps and zone boundaries can be defined, moved or 

deleted using either the tools on the toolbar or from within the configuration tabs. 

 The image window units are pixels; all coordinates for taps, zone boundaries and the cursor position 

are given in pixels of the imported image, with (0,0) being the top left-hand corner of the image. 
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 When the cursor is positioned over the image window, the current cursor x- and y-coordinates (in 

units of pixels) are displayed at the bottom-left of the main form. 

Configuration tabs.  Below the toolbar on the left-hand side of the main form are the configuration 

tabs.  In the configuration tabs all the settings for the definition of zones and taps, and the processing 

and display of pressure data and contours, are controlled.  The contour colouring, transparency, legend 

settings, text fonts and other settings can also all be adjusted.  Most settings are self-explanatory, 

however, a few need further explanation and are detailed in the next section. 

Configuration Settings 
The first step when configuring R-TAC is to load an image, as other functions will not operate until this 

is done.  Once an image is loaded, zone and tap definition can be configured in any order. 

The loading of an image is performed in the Image configuration tab, zones and taps are defined in the 

Zones and Taps tabs respectively, and other settings related to legends and labels are controlled in the 

Legend and Labels tabs. 

 Especially when configuring large numbers of taps or zones, it is recommended that the 

configuration be saved at regular intervals (remember to use Save As when creating a new set-up, 

or you will write over a previous configuration). 

Image tab.  The image tab is used to configure the image and contour appearance.  Images can be 

imported by clicking in the Image File, File Name box and browsing to select a JPG or BMP image of 

choice.  Once imported, the image file size in pixels is displayed below the filename.  The following 

points are worth noting about the functions in the Image tab: 

 Images can only be imported when R-TAC is in configuration mode 

 Contours and Data settings can be changed in either configuration or operational modes 

 The triangulation or grid multiplier setting increases the smoothness of contour levels between 

taps by using spline interpolation to increase the effective number of tap points; the higher the 

triangulation setting, the smoother the contours. 

 Increasing the number of contour levels produces a smoother contour map, while reducing the 

number of contour levels produces more distinction between different contour bands and has an 

averaging effect within the bands. 

 Reducing the opacity makes the contours more transparent and allows the background image to 

show through the contour map. 

 The Data Type setting allows the user to select which type of data will be used to generate 

contours: mean, minimum, maximum or RMS pressure data. 

 Changing the Contours and Data settings in operational mode, while measuring or replaying real 

pressure data, is a good way to instantaneously see the effect of different settings and become 

familiar with them. 

 With uneven grids of pressure taps, especially where the grid is elongated in one direction, high 

triangulation settings may give unsatisfactory results.  When this happens it is recommended that the 

triangulation be reduced, until a more reasonable contour map is achieved. 

Labels & Legend tabs.  Both labels and the legend can be displayed in either configuration or 

operational mode.  It is recommended that users experiment with the different settings in these tabs in 

order to become familiar with their functions. 

Taps tab.  The Taps tab is where the pressure tap locations are defined.  This can only be done when R-

TAC is in configuration mode.  Use the tools on the toolbar (see page 15) to initially place pressure taps 

on the imported image.  As each tap is added, it is listed in the Tap tab on the left of the screen.  
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 Taps are automatically added in channel order, however, the user can change the channel 

number assigned to a tap, or assign an equation involving a number of channels, by directly 

editing the Equation column 

 Channel numbers correspond to the DP module channel numbers and are designated by 'chXX', 

where 'XX' is the channel number 

 Users can designate their own label for each tap, by directly editing the Label column 

 Fine tuning of tap position can be done by directly editing the X and Y coordinates in the list, 

and then pressing the Update button at the bottom of the tab to see the effect of the changes 

 Right-clicking on a particular tap in the list brings up a context menu that allows the user to 

insert a new tap above the current tap in the list, delete the current tap, or clear all taps in the list 

 The settings at the top of the Taps tab allow the user to choose whether the taps are visible over 

the imported image, and change their size and colour 

 The equation feature supports most basic mathematic operations including: +, -, /, *, ( ), sqr, sqrt, 

abs, max, min, trunc, ceil, floor, as well as trigonometric, logarithmic and exponential functions. 

 Settings controlling Label appearance are in the Labels configuration tab 

Zones tab.  The Zones tab is where the zones, over which contours are required to be generated, are 

defined.  This can only be done when R-TAC is in configuration mode.  An imported image may have 

pressure taps on several different areas or faces and it is not required that contours be interpolated 

between taps in these different areas.  Therefore, each contour generation area is defined by its own 

zone.  R-TAC is able to support a large number of separate zones.  Use the tools on the toolbar (see page 

15) to initially define zones on the imported image. 

 Each zone must contain at least 3 pressure taps in order for contours to be generated, however, 

contour quality increases with increasing tap numbers and regularity of tap positions in a zone 

 The contour region is defined by the outermost tap positions within a particular zone 

  If a zone only has taps in a straight line, 

contouring will not occur because triangulation 

cannot be performed.  In this situation, placing 

an extra or 'dummy' tap next to the existing tap 

on the image, and assigning it to the same 

channel as the tap it is next to, will allow 

triangulation to occur over a narrow strip 

formed by the two rows of taps. 

 Fine tuning of zone vertices can be done by 

directly editing the X and Y coordinates in the 

list, and then pressing the Update button at the 

bottom of the tab to see the effect of the changes 

 The settings at the top of the Zones tab allow the user to choose whether the zone boundaries 

are visible in configuration mode, as well as change their colour 

 In order for the data from particular taps to be contoured, they must be included within a zone 

boundary 

 

 

Figure 10: Application of dummy taps to visualise 

pressures from a linear tap configuration 

Dummy taps 

Actual taps 
positions 
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Operation 

The basic operation of the DPMS is outlined in Figure 11, which shows the main screen that appears 

when the Device Control software is run – refer to the on-line User’s Guide for complete details. 

 

 

 

Figure 11: The Main screen of the TFI Device Control software & how to obtain data 

 

 The Data Output Rate is that required for the data that is written to a file or displayed on the screen 

and is different to the Acquisition Scan Rate (see the Sampling Rate section below). 

 The DPMS should be ‘zeroed’ regularly to remove offset voltages from the pressure transducers.  

Offsets change with variations in temperature and movement of the transducers.  While zeroing, the 

flow should be stopped, or the pressure measurement points completely shielded from the flow. 

Optional step: 
Set the working fluid 
temperature & pressure 

Step 2: 
Set the sampling time 
& data output rate 
(see note below) 

Step 4: 
Select the directory 
and file name for 
the output data 

Step 3: 
Select the data 
to be output 

Step 5: 
Click here to 
remove 
transducer offsets 

Step 7: 
Click here to sample 
data to disk 

Step 6: 
Click here to monitor DPMS 
channel data using the Data 
Display Form or R-TAC 

Toolbar 

Step 1:  
Click here to 
configure R-TAC  
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While obtaining data via sampling or the Real-Time Monitor, the R-TAC main form will be shown.  

However, it is also possible to view the pressure signals from individual channels using the Data 

Display Form, Figure 12.  During sampling or monitoring, this can be found behind the R-TAC main 

form by minimising the R-TAC form or using Alt-Tab to select the Data Display Form.  The main 

features of the Data Display Form are shown below.  The user can choose which type of data to display 

(mean, minimum, maximum and rms) in the Mean Data boxes at the top of the form, by going to the 

Display Data menu.  Either time history data or frequency spectra can be displayed in the plot window. 

 

 

Figure 12: The Data Display screen of the TFI Device Control software 

 

 After using the DPMS for a short time, you should refer to the on-line User’s Guide to gain a better 

understanding of the DPMS’ operation and characteristics. 

Sampling and Data Rates 
Two terms are used to configure the sampling and data rates: Acquisition Scan Rate and Data Output 

Rate.  The Acquisition Scan Rate is the frequency that the analogue data are sampled at, and is the 

sampling rate per channel.  It must be set high enough to avoid aliasing; typically at least 2 kHz/channel 

is required for a DP Module.  The Acquisition Scan Rate multiplied by the number of channels being 

sampled must also be lower than the A/D card maximum sampling rate.  Ideally, in order to maximise 

accuracy, the Acquisition Scan Rate should be below 80% of the A/D card maximum sampling rate 

divided by the number of channels being sampled. 

channels sampled of number

rate sampling maximum card A/D
Rate Scan nAcquisitiokHz  80.02  

Progress indicator 
(only used when saving 
data to disk) 

Plot of time or frequency spectra data 
(can be zoomed and panned) 

Controls for selecting 
what data to plot and 
the plot type (time or 
frequency spectra) 

Mean data from DPMS 
(right-click to change 
what data is displayed) 

Warning displays 

Control to pause and 
resume plotting, or redraw 
when replaying data 

Controls to save 
and print plots 
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The Acquisition Scan Rate setting is found by selecting Advanced from the Settings menu and clicking 

on Show Advanced Settings. 

The Data Output Rate is the frequency at which data are output to screen and file.  This rate must be 

equal to or less than the Acquisition Scan Rate.  The Data Output Rate is achieved by decimating (low-

pass filtering and down sampling) data from the Acquisition Scan Rate down to the required Data 

Output Rate.  This allows data to be sampled at a sufficiently high frequency to prevent aliasing while 

outputting data at a lower rate if only low frequency components are required.  A higher Acquisition 

Scan Rate also helps to reduce measurement noise. 

The Data Output Rate setting is found by selecting Sampling from the Settings menu. 

 

DPMS Calibration 

The DPMS is supplied fully calibrated and ready to use.  However, the user may wish to occasionally 

perform a ‘static’ calibration of the transducers – see the User’s Guide for details. 

 

Data Output Files 

There are two common data output files: plain text summary files and binary time-history (TH) files.  

The summary files contain an overall summary of the measured data for each channel.  The TH files 

contain time-varying pressure data for each channel at the specified data output rate. 

Data Replay 
Previously saved data can be replayed at a later date for viewing. 

 On the Device Control software main form, select View Time History File … from the Utilities 

menu – this opens the Time-History-File Replay Control form 

 Under Options, if the data being replayed was measured using multiple DP modules, select 
Check for Multiple Devices 

 If the data is to be viewed as a time-history pressure signal, do not select Use R-TAC 

 If the data is to be viewed as animated contours, select Use R-TAC, then 

o Select Config R-TAC 

o Load the configuration file that was originally used with the data to be replayed 

(or configure R-TAC as detailed on pages 14-18) 

o Close the R-TAC  main form 

 On the Time-History-File Replay Control form, click on Select File, browse to find the 

required data file, and select Open 

 Finally, select Play.  The Data Display form, and the R-TAC form if required, will open and 

proceed to play the data 

 The Pause button on the Time-History-File Replay Control can be used to pause the playback at 

any time 

 The Time-History-File Replay Control can be moved around the screen during playback, in order 

to better see the R-TAC or Data Display forms.  Alternatively, selecting the Hide button will 

minimise the Time-History-File Replay Control.  (Use Alt-Tab to re-maximise it) 

 During playback of animated contours, the Data Display form can be viewed at any time by 

minimising the R-TAC form or using Alt-Tab to select the Data Display form 
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 Selecting Show Entire File on the Time-History-File Replay Control will display the entire file in 

the Data Display form 

Creating Movie Files 
Previously measured data can also be used to create a movie file of the animated contouring for reports 

and presentations. 

 On the Device Control software main form, select R-TAC to AVI Conversion… from the 

Utilities menu – this opens the R-TAC to AVI main form 

 Under R-TAC Configuration, select Config R-TAC and load the configuration file that was 

originally used with the data that is to be converted to a movie file (or configure R-TAC as 

detailed on pages 14-18).  Once configuration is complete, close the R-TAC form. 

 In R-TAC Data File, if the data being converted was measured using multiple DP modules, 

select Check for Multiple Devices.  Then choose the data file for conversion by clicking on 

Select, browsing to the file and selecting it. 

 In AVI Output File, click on Select and set the file name to be used for the created movie file 

 Under AVI Options, choose the compression type and movie quality level.  The default data 

output rate is displayed in the bottom box.  If a lower output data rate is desired (gives a smaller 

file size), select Limit Data Rate and enter the required Data Rate Limit. 

 Finally, under Conversion select Make AVI 

Exporting Data - MATLAB® 
Functions for loading time-history data into MATLAB

®
 are installed by default with the Device Control 

software.  To use the supplied functions the directory containing the m-files must be added to the 

MATLAB
®
 path.  By default the m-files are located in  

C:\Program Files\Common Files\TFI\Matlab m-files 

To load a TH file, enter the following command in MATLAB
®
: 

[x, s] = ReadTHFile; 

MATLAB
®
 is not case sensitive for commands and either ‘readthfile’ or ‘readTHfile’ will work. 

Data from each channel will be loaded into a column of x, while details including data rate, channel 

names and units will be loaded into s (note that s is an optional output argument).  There are several 

options for using the ReadTHFile function; for more details enter  

help ReadTHFile 

Exporting Data – Other Programs 
For other programs, the binary time-history (TH) data files can be converted to plain text files by using 

the Time History File Conversion utility under the Utilities menu.  Many applications such as 

spreadsheets can then load this data.  The file format used by the binary TH files is available for users 

who wish to write code for importing data directly into other programs. 
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FURTHER INFORMATION 

The hardware and software described here have been designed to be as easy as possible to use.  All 

details required for general operation are described in this guide.  However, if you have specific 

questions or require further information on the set-up and operation of the DPMS and Device Control 

software, send an email to support@turbulentflow.com.au. 

Help Hints 

Placing the mouse cursor over a control in the Device Control software will display a brief hint 

describing its function. 

 To enable the Help Hints function, ensure that Show Help Hints is selected in the Help menu. 

Context Sensitive Help 

Help about specific controls in the software can be accessed by selecting a control in the software and 

pressing the F1 key. 

mailto:support@turbulentflow.com.au

